Training

Microsoft Excel 2013

Practice exercises
Table of Contents

Working with MS Excel ................................................................. 2

Project 2-5: Creating a Home Sales Workbook ................................................................. 2
Project 2-6: Using Flash Fill .................................................................................. 2

Using Office Backstage .................................................................................. 3

Project 3-5: Manage a Custom ribbon ................................................................. 3

Using basic Formulas ...................................................................................... 4

Project 4-3: Link to Data in other Worksheets within a Workbook ................................. 4
Project 4-4: Use external references ...................................................................... 4
Project 4-5: Name a range and Use the range in a Formula ......................................... 6
Project 4-6: Create a Personal Budget ..................................................................... 6

Using Functions ............................................................................................ 8

Project 5-5: Build Formulas to Track merchandise stock Levels ............................... 8
Project 5-6: Complete the analysis sheet in the Budget Workbook ......................... 8

Managing Worksheets .................................................................................... 9

Project 8-1: Music store annual sales sheet ............................................................ 9
Project 8-2: Photo store accessory sales tracker ...................................................... 10
Project 8-3: Pet store Daily sales tally, Part 1 .......................................................... 11
Project 8-4: Pet store Daily sales tally, Part 2 .......................................................... 12
Project 8-5: Bakery sales template ........................................................................ 13
Project 8-6: Bakery sales error correction ............................................................... 14

Working with Data and Macros ........................................................................ 14

Project 9-2: Subtotalling - Fundraising revenue summary ...................................... 15
Project 9-3: Hot sauce sales report ......................................................................... 15

Using Advanced Formulas .............................................................................. 17

Project 10-1: Separating text into Columns – SFA Grades ...................................... 17
Project 10-2: Creating SUMIF and SUMIFS Formulas to Conditionally summarize Data ................................................................. 17
Project 10-3: Using a Formula to Format text .......................................................... 18
Project 10-4: Create COUNTIF and AVERAGEIF Formulas .................................. 18
Project 10-5: Creating Conditional Logic Formulas .............................................. 18
Project 10-6: Creating COUNTIF, AVERAGEIF, and LOOKUP Formulas .................. 19
**Project 2-5: Creating a Home Sales Workbook**

CEO, Richard Carey has asked you to keep track of the Home sales for the Fabrikam staff.

1. Open the 02 Home Sales Q1.xlsx workbook.
2. SAVE it with the name **02 Home Sales Q1 Solution**.
3. Click into cell A3 and type First Quarter 2014.
4. Insert a blank row below row 3
5. SAVE the workbook.

LEAVE this workbook open for the next project.

---

**Project 2-6: Using Flash Fill**

Fabrikam’s director has asked you to redo the workbook you created in Project 2-5 with separate columns for first name and last name and sequentially numbered sales.

1. Use the workbook from the previous project
2. Insert two columns to the right of the “Agent” columns, and type in “First Name” as the label for column B and “Last Name” for column C
3. Use Flash Fill to create a list of first names in column B and a list of last names in column C. To do this – enter the first of the first names (i.e. Kim), then hit enter. You will move to the next row - enter **only the first letter** of the second agent – note that the column will be filled with all the first names in faded out font. Finally, hit enter to fill out the names. Repeat for last names. NOTE: If this does not work as intended, delete “Kim” and any other name you have entered and start again. This feature only works when you type the first letter of the second name.
5. In A5, type item# and then use Auto Fill to create numbers starting with 1 that are sequential through 14.
6. Add a label in A3 that says 2014 to-Date.
7. Make sure there is a blank row 4.
8. SAVE the workbook as 02 Home Sales Flash Fill Solution.
Project 3-5: Manage a Custom ribbon

In order for your client to use and maintain the invoice you downloaded in the previous exercise, he has requested that you customize several tabs on the ribbon to make the worksheet easier to manage and edit.

GET READY. LAUNCH Excel if it is not already running.

1. OPEN 03 My Invoice Solution from the Lesson 3 folder, if necessary.
2. OPEN Backstage view, and click Options.
3. In the Excel Options dialog box, click the Customize Ribbon tab.
4. Click the Reset button at the bottom right of the window and click Reset all customizations. When prompted to delete all customizations, click Yes.
5. Create a new tab named Invoice Edits.
6. Rename the new command group in Invoice Edits to Invoice Tools.
7. Select five commands to add to the Invoice Tools command group.
8. Create another new tab named My Edits.
9. Rename the new command group in My Edits to My Tools.
10. Add five commands to the My Tools command group.
11. Click OK.
12. Examine your changes to the ribbon.
13. OPEN Backstage view and click Options. Undo all the changes you just made to the ribbon. When prompted to delete all customizations, click Yes.

LEAVE Excel open for the next project.
Project 4-3: Link to Data in other Worksheets within a Workbook

You work for A. Datum Corporation as an accountant. You have a workbook with several sheets that contain budgets for western division offices located in Alaska, Washington, Oregon, and California. You created a summary sheet and named the sheet tab western summary. You will link to information in the four other worksheets to present summary data in one place. Each area worksheet is organized the same way to make it easy to find the same kind of data for each area.

GET READY. Before you begin these steps, OPEN the 04_ADatum_Start workbook.

1. On the Western Summary sheet, click cell B3 and create the formula =alaska!B8 (using the mouse not by typing this formula in directly). The formula links to the data in cell B8 (the Gross Sales total) on the Alaska worksheet and displays it in cell B3 of the Western Summary worksheet.

2. In B4, create the formula =washington!B8 to link to the Washington office gross sales total.

3. Create similar formulas to display the Oregon and California gross sales data on the Western Summary sheet.

4. Compare the figures in column B on the Western Summary sheet to the appropriate cells in the other worksheets to verify that your formulas are correct. If not, adjust the formulas on the Western Summary sheet to correct them.

5. Create similar formulas to display the COGS totals in column C, the commissions totals in column D, and the net sales totals in column E on the Western Summary sheet. (To save time, you can select B3:B6 and drag the fill handle to the right to fill all additional totals.)

6. Compare the figures on the Western Summary sheet to the other worksheets to verify that your formulas are correct. If not, adjust the formulas to correct them.

7. SAVE the workbook in your Lesson 4 folder as 04_ADatum_USWest Solution and CLOSE it.

LEAVE Excel open to use in the next project.

Project 4-4: Use external references

You now want to create a summary in a workbook named 04_ADatum_GlobalSales and link to information in the 04_ADatum_USWest workbook.

GET READY. LAUNCH Excel if it is not already running.

1. OPEN 04_ADatum_USWest and 04_ADatum_GlobalSales from your data Files.

2. In 04_ADatum_GlobalSales, on the Global Summary sheet, click cell B4 to make it active.

3. Create the following formula (using the mouse – not typing in directly) =04_ADatum_USWest!westernSummary!B8. The formula links to the data in cell B8 on the Western Summary sheet in the 04_ADatum_USWest workbook. Make sure you remove absolute references (by using the F4 function key or deleting manually).

5. SAVE the 04_ADatum_GlobalSales workbook and leave it open.
6. In 04_ADatum_USWest, on the California tab, change the data in cell B6, which is the Gross Sales figure for Release 3.4, to 284,125.
7. Check the Western Summary sheet to verify that the linked cell updated automatically.
8. Save the 04_ADatum_USWest workbook and Close it.
9. CLOSE 04_ADatum_GlobalSales without saving the workbook.
10. Reopen 04_ADatum_GlobalSales.
11. Click enable Content, if prompted.
12. Click Update if the message window appears.
13. OPEN 04_ADatum_USWest.
14. Verify that the data in cell B4 in 04_ADatum_GlobalSales matches the corresponding data in 04_ADatum_USWest.
15. SAVE 04_ADatum_USWest in your Lesson 4 folder as 04_ADatum_USWestSales Solution.
16. SAVE 04_ADatum_GlobalSales in your Lesson 4 folder as 04_ADatum_GlobalSales Solution.
17. CLOSE both workbooks.

LEAVE Excel open for the next project.
Project 4-5: Name a range and Use the range in a Formula

Blue Yonder Airlines wants to analyse the sales and expense data from its four-year history.

GET READY. LAUNCH Excel if it is not already running.

1. OPEN the 04 Income Analysis workbook for this lesson.
2. On the Sales sheet, select B4:E4 and use the Define name command on the FORMULAS tab to name the range. Accept the defaults in the dialog box.
3. Select B5:E5 and use the Name box to name the range. Use the row heading as the range name using an underscore to separate the words.
4. Select A6:E6. Use the Create from Selection command on the FORMULAS tab to name the range. Use the default option in the dialog box.
5. Create a named range for A7:E7 using the method of your choice.
6. Create a formula in cell F4 that sums the values in B4:E4 using the range name.
7. Repeat Step 6 for the other three income sources.
8. Create range names on the Expenses sheet using the method of your choice.
9. Total the four expense categories on the Expenses sheet as you did on the Sales sheet. Be careful to select the worksheet range name rather than the workbook range name in each case. You use this workbook again in Lesson 5 and create formulas with functions on the Analysis sheet.
10. SAVE the workbook in your Lesson 4 folder as 04 Income Analysis Solution and then CLOSE the File.

LEAVE Excel open to use in the next project.

Project 4-6: Create a Personal Budget

Most people agree that it is vitally important for a business to have a realistic budget. It is equally important for an individual to have a personal budget—a plan for managing income and expenses. Using a personal budget worksheet prepopulated with data, create range names to identify specific blocks of data, and then use those range names in formulas you create to compare budgeted to actual costs.

GET READY. LAUNCH Excel if it is not already running.

1. OPEN the 04 Personal Budget Start workbook for this lesson.
2. On the Expenses sheet, name cell B7 income_total. If you use the Define Name command, use the defaults in the New Name dialog box.
3. Name cells B10:B14 Home_total.
4. Create named ranges similar to Step 3 for budgeted amounts for the Daily Living Total, Transportation Total, and Entertainment Total categories.
5. Create a formula in cell D4 that subtracts the actual amount from the budgeted amount. The cells in column D are formatted to display a dash if the budgeted amount and the actual amount are the same. Copy the formula in D4 to D5:D6.
6. Create a formula in cell D7 that subtracts the actual amount from the budgeted amount using the Income_Total range name.
7. Beginning with the Home section, create a formula in the non-Total cells in column D that subtracts the actual amount from the budgeted amount using the range name for the budgeted amount. For example, the formula in cell D10 would be =Home_Total-C10. Be aware that the formulas might result in a positive number, no difference, or negative numbers.

8. Beginning with the Home section, create a formula in the Total cells in column D that subtracts the actual amount from the budgeted amount. Use the cell address for the budgeted amount.

9. In cells E10 through E14, create a formula that divides the budgeted amount by the income total. Use the range names Home_Total and Income_Total in the formula.

10. In cell E15, create a formula that divides the budgeted amount by the income total using a cell reference to the Home total and the range name Income_Total.

11. Complete column E per Steps 9 and 10 for the remaining cells.

12. The figure that displays in cell B36 is based on a named range, but part of the range is incorrect. Use the Name Manager or the Show Formulas command to analyse the formula for the Expenses range and correct it.

13. SAVE the workbook in your Lesson 4 folder as 04 Personal Budget Solution and then CLOSE the File.
Using Functions

Chapter 5 - Mastery assessment

Project 5-5: Build Formulas to Track merchandise stock Levels

Wide World Importers sells a variety of fine wool rugs, textiles, ceramics, furniture, and statues from the Middle East. The company tracks levels of stock in nine different categories, and keeps several units of each type of stock in five warehouses spread across the region. You have been asked to track all 45 stock levels.

GET READY. Launch Excel if it is not already running.

1. Open 05 Importers Stock from the data Files for this lesson.
2. Use the Sum formula to total the number of stock units in each warehouse.
3. Calculate the number of stock units that are at zero (0) across all six warehouses in cell B14.
4. Calculate the maximum number of stock units in any warehouse in cell B15.
5. Calculate the minimum number of stock units in any warehouse in cell B16.
6. Save the workbook to your Lesson 5 folder as 05 Importers Stock Solution and then CLOSE the File.

Leave Excel open for the next project.

Project 5-6: Complete the analysis sheet in the Budget Workbook

Blue Yonder Airlines wants to analyse the sales and expense data from its four-year history. You will complete the Analysis sheet to summarize the data.

GET READY. Launch Excel if it is not already running.

1. Open 05 Income Analysis Start from the data Files for this lesson.
2. On the Analysis sheet, calculate average sales for each of the four service categories using range names. use name Manager to examine range names in the workbook before you enter the formulas.
3. Calculate the average expenses for each of the four service categories.
4. Calculate the maximum sales for each of the four service categories.
5. Calculate the maximum expenses for each of the four service categories.
6. Save the workbook to your Lesson 5 folder as 05 Income Analysis Solution and then CLOSE the File.

CLOSE Excel.
Managing Worksheets

Project 8-1: Music store annual sales sheet

You are performing accounting for a chain of sheet music and collectable CD stores throughout the state. In this project, you rename a worksheet, use the Name box to navigate a worksheet, and copy an existing worksheet.

GET READY. LAUNCH Excel if it is not already running.

1. OPEN 08 Brooks Music Annual Sales from the data Files for this lesson
2. SAVE the workbook as 08 Brooks Music Annual Sales 2013 Solution.
3. On the HOME tab, in the Cells group, click Format. Click Rename Sheet.
4. Type Q1 and press enter.
5. Click Format again, and then click Move or Copy Sheet.
6. In the Move or Copy dialog box, click (move to end), click Create a copy, and then click Ok.
7. Rename the Q1 (2) sheet as Q2.
8. In the Q2 worksheet, select cell C5.
9. Delete the text Jan and replace it with Apr.
10. Use AutoFill to change the next two months’ column headings, and then change Qtr 1 to Qtr 2.
11. Click the name box, and then enter the cell reference C6:E10. Press enter, and then press Delete.
12. For the months in the second quarter, enter the following values:

| €22,748.00 | €21,984.00 | €20,194.00 |
| €22,648.00 | €21,068.00 | €21,698.00 |
| €24,971.00 | €23,498.00 | €23,011.00 |
| €23,400.00 | €24,681.00 | €23,497.00 |
| €21,037.00 | €20,960.00 | €19,684.00 |

13. If necessary, adjust the width of each column so that the entries are legible. SAVE and CLOSE the workbook. LEAVE Excel open for the next project.
Project 8-2: Photo store accessory sales tracker

You’re helping a photo development kiosk at a local office supplies store to keep track of the extra sales its employees have to produce in order to keep a development shop open in the digital camera era. In this lesson, you rename worksheets, unhide a hidden form worksheet, arrange windows onscreen, and make changes.

GET READY. LAUNCH Excel if it is not already running.

1. OPEN 08 Photo Weekly Product Tracker from the data Files for this lesson.
2. SAVE the workbook as 08 Photo Weekly Product Tracker 290316 Solution.
3. Click the Sheet1 worksheet tab.
4. Repeat this process for the sales associates in Sheet2 and Sheet3.
5. Unhide the Form sheet.
6. Copy the Form sheet to before itself.
7. Click cell A7. Type the name Jairo Campos.
8. Edit cell B4 to reflect the date shown in the other worksheets.
9. Rename the Form (2) worksheet Jairo.
10. Right-click the Form tab. Click Hide.
11. Select cells B9:H13 and type the values for each of the days shown in the following table, skipping blank cells as indicated:

<table>
<thead>
<tr>
<th>Sunday</th>
<th>Monday</th>
<th>Tuesday</th>
<th>Wednesday</th>
<th>Thursday</th>
<th>Friday</th>
<th>Saturday</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>3</td>
<td>4</td>
<td>4</td>
<td>6</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>1</td>
<td>2</td>
<td>4</td>
<td></td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>400</td>
<td>75</td>
<td>150</td>
<td>2</td>
<td></td>
<td>200</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>4</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

13. Select the akira worksheet.
14. On the VIEW tab, in the Window group, click new window.
15. In the new window, select the taneel worksheet.
16. In the new window, select the Kere worksheet.
17. Once again, on the VIEW tab, in the Window group, click new window.
18. In this new window, select the Jairo worksheet.
19. In the Jairo worksheet, on the VIEW tab, in the Window group, click arrange all.
20. In the Arrange Windows dialog box, click tiled. Click windows of active workbook. Click Ok.

SAVE this workbook and CLOSE all windows related to it. LEAVE Excel open for the next project.
Project 8-3: Pet store Daily sales tally, Part 1

You have been asked to build a daily accounting system for a pet supplies store, which has been keeping its receipt records on paper. In this project, you insert one new worksheet, make a copy of another, and adjust the view to show multiple worksheets at one time.

GET READY. LAUNCH Excel if it is not already running.

1. OPEN 08 Pet Store Daily Sales from the data Files for this lesson.
2. SAVE the workbook as 08 Pet Store Daily Sales 290316 Solution.
3. Right-click the Sheet1 tab on the tabs bar. Click Rename.
4. Type March 9 and press enter.
5. On the HOME tab, in the Cells group, click the down arrow next to insert. Click insert Sheet.
6. In the tabs bar, drag the new worksheet to the end of the sequence after March 9.
7. Click the March 9 tab. Use the Name box to select cells B52:E67.
8. On the HOME tab, in the Clipboard group, click Cut.
9. Click the tab for the new worksheet. On the HOME tab, click Paste.
10. Adjust the width of columns A through D to fit their contents (see Lesson 7).
11. Rename the new worksheet Recap.
12. Click the March 9 tab. On the HOME tab, in the Cells group, click Format. Click Move or Copy Sheet.
13. In the Move or Copy dialog box, in the Before sheet list, click Recap.
14. Click Create a copy. Click Ok.
15. Rename March 9 (2) to March 10.
16. Right-click the Recap tab. Click Hide in the menu.
17. Click the March 9 tab.
18. On the VIEW tab, in the Window group, click new window.
19. In the newly opened window, click the March 10 tab.
20. On the VIEW tab, click arrange all.
21. In the Arrange Windows dialog box, click Vertical. Click Ok.
22. In the March 10 worksheet, edit the date to reflect Sunday, March 10.
24. Select cells B10:F17 and type the following data:

<table>
<thead>
<tr>
<th></th>
<th>Golden Retriever</th>
<th>Dog</th>
<th>Bob Cook</th>
<th>€</th>
</tr>
</thead>
<tbody>
<tr>
<td>4189</td>
<td></td>
<td>Dog</td>
<td>Bob Cook</td>
<td>201.5</td>
</tr>
<tr>
<td>5164</td>
<td>Leash</td>
<td>accesso</td>
<td>Bob Cook</td>
<td>13.95</td>
</tr>
<tr>
<td>3478</td>
<td>Puppy food</td>
<td>Feed</td>
<td>Bob Cook</td>
<td>38.95</td>
</tr>
<tr>
<td>5299</td>
<td>Kitty litter</td>
<td>accesso</td>
<td>Bob Cook</td>
<td>21.95</td>
</tr>
<tr>
<td>3218</td>
<td>Fish food</td>
<td>Feed</td>
<td>Alice</td>
<td>11.21</td>
</tr>
<tr>
<td>4855</td>
<td>Persian kitten</td>
<td>Cat</td>
<td>Alice</td>
<td>185.7</td>
</tr>
<tr>
<td>5546</td>
<td>Food bowl</td>
<td>accesso</td>
<td>Alice</td>
<td>7.85</td>
</tr>
<tr>
<td>3421</td>
<td>Kitten food</td>
<td>Feed</td>
<td>Alice</td>
<td>38.55</td>
</tr>
</tbody>
</table>

SAVE this workbook and LEAVE it and Excel open for the next project.

**Project 8-4: Pet store Daily sales tally, Part 2**

You have a handful of worksheets to work with now, but they look a bit dull. In this project, you make changes to one worksheet and have them reflected in another, and then copy formulas in one worksheet to another range of the worksheet and use Find and Replace to edit those formulas to reflect a different day.

GET READY. LAUNCH Excel if it is not already running.

1. SAVE the workbook as **08 Pet Store Daily Sales 290316 Solution 2**.
2. Arrange separate windows for the March 9 and March 10 worksheets, if they are not already arranged this way.
3. In any open window, right-click any worksheet’s tab and click **Select all Sheets** in the shortcut menu.
4. Select column **A** in its entirety.
5. On the HOME tab, in the Cells group, click **Delete**.
7. On the HOME tab, in the Font group, click the **Fill Colour** arrow button. In the palette, click the swatch labelled **Blue, accent 1, Lighter 60%**.
8. Right-click a worksheet tab on either worksheet. Click **Ungroup Sheets**.
9. Right-click a worksheet tab again, and this time click **Unhide**. In the Unhide dialog box, choose **Recap**. Click **Ok**.
10. Click cell **B1**. Type **Saturday** and press **enter**.
11. In the Name box, type **B1:D16** and press **enter**.
12. On the HOME tab, in the Clipboard group, click the **Copy** button.
13. Select cell **B20**.
14. Click the **Paste** button.
15. Select cell **B20** again. Type **Sunday** and press **enter**.
16. Select cells **B21:D35**.
17. On the HOME tab, in the Editing group, click **Find & Select**. Click **Replace**.
18. In the Find and Replace dialog box, if the options are not showing, click **options**. Click the within list box down arrow and choose **Sheet**. For the Look in list box, choose **Formulas**.
19. In the Find what box, type **March 9**. In the Replace with box, type **March 10**.
20. Click **Find next**. When C21 is the active cell, click **Replace**.
21. Keep clicking **Replace** until after cell **D35** has been processed. (The cell contents should
change from €35.90 to €163.45.) Close the dialog box at that point.

SAVE this workbook and CLOSE all windows associated with it.

---

**Chapter 8 - Mastery assessment**

**Project 8-5: Bakery sales template**

You’ve been given the task of bookkeeping for a not-for-profit bakery. It has one location but is soon to open a second. You’ve been handed a workable format for a daily retail tally sheet. Your instructions are to create a daily form that employees can use for an entire week’s worth of daily sales tallies. In this project, you take one day’s worksheet, hide rows that need to be seen only on occasion, and create enough copies for an entire work week.

GET READY. LAUNCH Excel if it is not already running.

1. OPEN **08 Whole Grains Daily Sales 130520** from the data Files for this lesson.
2. Open a blank workbook.
3. Use the VIEW tab to adjust the view so that both windows appear in the workspaceside-by-side.
4. If necessary, Adjust the magnification of the original workbook window so that you can see columns A through R all at once.
5. If necessary, Adjust the magnification of the blank workbook window (which probably has Book1 in its title bar) to the same value.
6. In the original workbook window, copy the entire sheet’s contents to the Clipboard.
7. In the blank workbook window, click cell A1 and paste the entire contents.
9. In the Book1 window, click the File tab. Click Save as, and then in Backstage, click Browse.
10. In the Save As dialog box, click the Save as type box, and choose excel template (*.xltx).
11. Click new folder. Type whole Grains and press enter.
12. Click in the File name box, and Save the template as **08 Whole Grains Daily Sales Solution.xltx**.
13. In the template workbook, hide rows 11 through 18.
14. Rename Sheet1 to Monday.
15. Make five copies of the Monday worksheet within the workbook template, and name them Tuesday through Saturday.
16. Arrange the worksheets by days of the week if necessary.

SAVE the workbook template and LEAVE both windows open for the next project.
Project 8-6: Bakery sales error correction

Something’s not tallying properly with the workbooks you’ve been given by your contact with the bakery. You learn that there’s an error in the formula used to calculate sales throughout an entire column. In this project, you use Find and Replace to make a complex formula correction, and you test the results on a daily worksheet made from your template.

GET READY. LAUNCH Excel if it is not already running.

1. OPEN 08 Whole Grains Daily Sales Form Solution.xltx and 08 Whole Grains Daily Sales 130520.xlsx if they are not already open.
2. Arrange the two Files in side-by-side vertical windows, if they are not already so arranged.
3. In the template window (the one with blank worksheets), group the six worksheets together, and then select cells M22:M45.

The nature of the error here is that the formula confuses “wheat rolls” with “white rolls,” and vice versa. Though you study much more about formulas in the lessons to follow, here all you need to know is that the terms for these pastries are juxtaposed with one another, and you can use Find and Replace to make them switch places.

4. Open the Find and Replace dialog box.
5. Set the options so that the search process looks through formulas in the entire workbook.
6. Make sure Match entire cell contents is deselected.
7. Click in the Find what box, and then type whiteroll.
8. Click in the Replace with box, and then type XXXXX.
9. Click Replace all. Some 144 replacements should have been made. Click Ok to dismissthe notice.
10. Repeat the process, this time replacing wheatroll with whiteroll.
11. Repeat one more time, replacing XXXXX with wheatroll. Click Close.
12. Ungroup the worksheets in the workbook template.
13. Save and Close the workbook template.
14. Click the File tab, and then click new.
15. In Backstage, click Personal. Double-click the whole Grains folder.
16. Double-click the whole Grains Daily Sales Form Solution template. A new workbook opens with the title “Whole Grains Daily Sales Form1 Solution.”
17. Save the new workbook in the Lesson 8 folder as 08 WG Sales 130520 Solution.
18. Arrange the two open workbooks to be side-by-side.
19. In the new workbook, open the Monday tab.
20. Copy the contents of cells A22:L45 from the original worksheet, to the new Monday worksheet. Cell M46 should read €453.29 (correct), not €452.93 (incorrect) as in the original worksheet.
21. Select the Saturday worksheet.
22. Select rows 10 through 19, including the hidden rows. Right-click the selection and click Unhide.
23. Change the price for a cinnamon bagel for Saturday to 75¢.
24. Hide rows 11 through 18 again.

SAVE the 08 WG Sales 130520 Solution workbook and CLOSE both workbooks.
Working with Data and Macros

Project 9-2: Subtotalling - Fundraising revenue summary
You’re a volunteer for a charity that generates money for worthwhile causes by gathering together famous athletes for public events. In this project, you will generate collapsible subtotal rows for a list of moneys raised at various tour stops.

GET READY. LAUNCH Excel if it is not already open.
1. OPEN 09 4Strong Tour Revenues.xlsx from the Files for this lesson.
2. SAVE the workbook as 09 4Strong Tour Revenues Summary Solution.xlsx.
3. Select the range A4:D232.
4. On the DATA tab, in the Outline group, click Subtotal.
5. In the Subtotal dialog box, set At each change in to Tour Stop Date. Set Use function to Sum (if not already set). Check only the Sales box under Add subtotal to. Check Summary below data. Click OK.
6. After the groups are all added, in the Outline group, click Hide Detail.
7. Expand column D if necessary to make room for the Grand Total at the bottom. SAVE and CLOSE this workbook. Leave Excel open for the next project.

Project 9-3: Hot sauce sales report
You work in the accounting department of a non-profit organization that manufactures jars of various recipes of Homemade hot sauce, for resale by charity groups. In this project, you combine three sheets worth of data into a single sheet that can be expanded and collapsed, and that shows subtotals for each month.

GET READY. LAUNCH Excel if it is not already open.
1. OPEN 09 Hot Sauce Sales Q1 from the Files for this lesson.
2. SAVE the workbook as 09 Hot Sauce Sales Q1 Report Solution.
3. Click the February tab.
5. Copy the range to the January worksheet starting at cell A32.
6. Adjust the formulas in Gross Sales for the copied region to point to the correct cells in the
Unit Prices worksheet, starting with cell B9.

7. Repeat the process, copying the range in the March worksheet to January, with the topleft cell in A58. Be sure to correct the Gross Sales formulas.

8. Adjust the height of rows with column headers to more appropriately fit their contents.

9. Click cell B4 and type First quarter 2013.

10. Click cell A6 and type January. Repeat this for the respective cells in the other two months’ tables.

11. Delete the February and March worksheets.

12. Rename the January worksheet First quarter.

13. Select row 17 and insert a new row.

14. Create AutoSum formulas for January Unit Sales columns B through J, giving a special boldface to J17.

15. Copy row 17 and insert it below the Unit Sales tables for the other two months.

16. Create AutoSum formulas for January Gross Sales columns B through I. Copy these formulas to February and March.

17. Select rows 8 through 16. On the DATA tab, in the Outline group, click the Group button.

18. Repeat this process for the remaining five tables.

19. Select columns B through I. Click the Group button.

20. Select the entire worksheet. In the Outline group, click Hide Detail. Both rows and columns are collapsed to reveal just the sales summaries. Widen column J, if necessary.

SAVE and CLOSE this workbook. Leave Excel open for the next project.
Project 10-1: Separating text into Columns – SFA Grades

In this project, you take a text File of student grades and separate the information into seven columns rather than one.

GET READY. LAUNCH Excel if it is not already running.

1. OPEN the 10 SFA Grades Import File.
2. Select cells A4:A41. Click the Data tab and in the Data Tools group, click text to Columns.
3. The Convert Text to Columns Wizard opens with Delimited selected as the default, because Excel recognized that the data in the selected range is separated with delimiters. Click next.
4. Select Comma and Space as the delimiters. If other delimiters are checked (such as Tab), deselect them and click next. Click finish.
5. Label each of the columns in row 3 (A3 through G3): Last, first, initial, iD, final, Quarter, Semester.
6. SAVE the workbook in the Lesson 10 folder as 10 SFA Grades Import Solution. CLOSE the workbook.

LEAVE Excel open for the next project.

Project 10-2: Creating SUMIF and SUMIFS Formulas to Conditionally summarize Data

Salary information for Contoso, Ltd. has been entered in a workbook so the office manager can analyse and summarize the data. In the following exercise, you calculate sums with conditions.

GET READY. LAUNCH Excel if it is not already running.

1. OPEN the 10 Contoso Salaries data File for this lesson.
2. Select cell C35. Click the Formulas tab and in the Function Library group, click insert function.
3. If the SUMIF function is not visible, type SUMIF in the Search for a function box and click Go. From the Select a function list, click SUMIF. Click Ok.
4. In the Function Arguments dialog box, in the Range field select C4:C33.
5. In the Criteria box, type >=100,000.
6. Click Ok. Because the range and sum range are the same, it is not necessary to enter a Sum_range argument.
7. Select C36 and click insert function. Select SUMIFS and click Ok.
8. In the Function Arguments dialog box, select C4:C33 as the sum range.
9. Select D4:D33 as the first criteria range.
10. Type >=10 as the first criterion.
11. Select C4:C33 as the second criteria range.
12. Type **<60000** as the second criterion. Click **Ok** to finish the formula.
13. SAVE the workbook as **10 Contoso Salaries Solution**. CLOSE the File. LEAVE Excel open for the next project.

**Chapter 10 - Proficiency assessment**

**Project 10-3: Using a Formula to Format text**

Use a formula to format text for employees to decide on 401K investments for Fabrikam, Inc.

GET READY. LAUNCH Excel if it is not already running.

1. OPEN the **10 Fabrikam Investments** data File for this lesson.
2. Enter formulas in column F to convert the text in column A to title case.
3. Copy the values from column F to column A and delete column F.
4. SAVE the workbook in the Lesson 10 folder as **10 Fabrikam Investments Solution** and then CLOSE the File.

LEAVE Excel open for the next project.

**Project 10-4: Create COUNTIF and AVERAGEIF Formulas**

In this exercise, you enter COUNTIF and AVERAGEIF formulas to analyse and summarize grades for a course at the School of Fine Arts.

GET READY. LAUNCH Excel if it is not already running.

1. OPEN the **10 SFA Grades** data File for this lesson.
2. In cell J2 enter a formula that counts the total number of students.
3. In the grades table on the right side of the worksheet, create formulas using COUNTIF that will count how many students got an A for the Final, Quarter, and Semester. In the Range field, use an absolute reference.
4. Create formulas for each of the other grades in the grades table.
5. SAVE the workbook as **10 SFA Grades Solution** and then CLOSE the File. LEAVE Excel open for the next project.

**Chapter 10 - Mastery assessment**

**Project 10-5: Creating Conditional Logic Formulas**

Professor Garrett Young has asked you to create formulas to identify the highest and lowest achieving students on his first test.

GET READY. LAUNCH Excel if it is not already running.

1. OPEN the **10 SFA Test Grades** File for this lesson.
2. In column F, use a function that will place the word “High” in each cell when the Test1 result is greater than 90. There will be a blank for all other values in this column.
3. In column G, use a function that will place the word “Low” in each cell when the test result is less than 70. There will be a blank for all other values in this column. **Best Practice Hint:** Use the cell references, F3 and G3 in your formulas rather than the actual words High and Low. Also use absolute referencing as you will be copying this formal down.

4. In cell A43, type **Count**, and then create two formulas that will count the High and Low labels in columns F and G.

5. SAVE the workbook in the Lesson 10 folder as **10 SFA Test Grades Solution** and then CLOSE the File.

**LEAVE Excel open for the next project.**

**Project 10-6: Creating COUNTIF, AVERAGEIF, and LOOKUP Formulas**

In this project, you use a lookup table to determine an employee’s end-of-year bonus.

**GET READY. LAUNCH Excel if it is not already running.**

1. OPEN the **10 Contoso Bonus** data File for this lesson.
2. In the table starting in row 35, create formulas to count the number of employees in each position in column B and the average salary of each position in column C.
3. Calculate the bonus by multiplying the Average salary by the rate/100.
4. Starting in F4, create a formula and copy it down that will look up the bonus for each position and put it in column F.
5. SAVE the workbook in the Lesson 10 folder as **10 Contoso Bonus Solution**, and then CLOSE the File.